Copyright

Manual copyright 2018 Integrity Data. All rights reserved.

Limitation of Liability

The content of this manual is furnished for informational use only, is subject to change without notice and should not be construed as a commitment by Integrity Data. Integrity Data assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Integrity Data nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damage, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

Publication Date

January 2018
## Contents

**Introduction** ................................................................................................................................................................ 5
  **Additional Settings that Impact FTE Manager** ........................................................................................................ 5

**Installation Overview** .................................................................................................................................................. 6
  **Prerequisite** .................................................................................................................................................................. 6
  **Install Notes** ............................................................................................................................................................... 6
  **Server/Client** ............................................................................................................................................................... 6
    **Files Installed** .......................................................................................................................................................... 12
    **Manual Install** .......................................................................................................................................................... 12

**Registration** ................................................................................................................................................................. 14
  **Activation Manager Window** .................................................................................................................................... 14
  **Test and/or Historical Companies** .......................................................................................................................... 15
  **Version Information** .................................................................................................................................................... 15

**Security Settings** ............................................................................................................................................................ 16
  **Status Setup Window** ................................................................................................................................................. 18
  **FTE Manager Password Setup Window** ................................................................................................................... 20
  **FTE Manager Pay Code Setup Window** .................................................................................................................... 22
  **Employee Maintenance Window** ............................................................................................................................... 24
  **Employee Additional Information Maintenance Window** ........................................................................................ 25
  **Employee Human Resources Maintenance Window** ............................................................................................... 26
  **FTE Manager Budget Maintenance Window** ........................................................................................................... 27
  **FTE Manager Maintenance Window** ........................................................................................................................ 29
  **FTE Manager Requisition Window** .......................................................................................................................... 33
  **FTE Manager Hire Window** ......................................................................................................................................... 35
  **Employee Positions Maintenance Window** ................................................................................................................ 36
  **FTE Manager Statistics by Status Window** ................................................................................................................ 42
  **FTE Manager Budget Import Window** ........................................................................................................................ 44
  **Copy Employee Positions Window** ......................................................................................................................... 46

**Payroll Processing** ........................................................................................................................................................ 47
  **Fiscal Year End Process** .............................................................................................................................................. 48
  **Organizational Explorer Window** ............................................................................................................................... 49
  **Exporting Utilizing SmartList Builder** ..................................................................................................................... 50
  **Activation Manager Messages** .................................................................................................................................. 54

**Deactivate Product** ...................................................................................................................................................... 55
Uninstall ................................................................................................................................................................ 55
Uninstall Activation Manager ............................................................................................................................. 56
Contact Information ................................................................................................................................................ 57
**Introduction**

FTE Manager enables companies to Budget and Manage by job for individual Fiscal Years and/or Fiscal Periods. In addition, companies will have the ability to compare Budget Amounts to Actual Amounts in both Dollars and FTEs (full-time equivalents).

FTE Manager has the ability to Import from standard CSV (comma separated value) text files which enables users to do all their budgeting and comparisons to Actual in their favorite spreadsheet application such as Microsoft Excel. All pertinent Budget and Actual Amounts are made easily available to SmartList Builder enabling users to Export previous Year Budgets and Actual Amounts for future Fiscal Year budgeting.

FTE Manager is tightly integrated with Microsoft Dynamics GP Payroll and Human Resources modules, providing a seamless solution for companies looking to better manage their pool of resources.

**Additional Settings that Impact FTE Manager**

Microsoft Dynamics GP > Tools > Setup > System > Human Resources Preferences

Administration > Setup > System > Human Resources Preferences

Automatically Create/Update Vacancies option should be set to Never to ensure Microsoft Dynamics GP Core vacancy information stays in sync with FTE Manager.
Installation Overview

This section will discuss the prerequisites, list the files installed and go through the install process. The HRM Solution Series Extensions consists of two modules that provide additional capabilities for an existing Microsoft Dynamics GP installation: Employee Accounts and Splits and FTE Manager.

Prerequisite

The prerequisite for FTE Manager is:

- Employee Accounts and Splits: U.S. Payroll
- FTE Manager*: Human Resources

* U.S. Payroll is required to use the full functionality of FTE Manager.

Install Notes

Prior to installing complete the steps:

- Confirm all users are logged out of Microsoft Dynamics GP
- Complete all payroll runs and validate no payroll runs are in process
- Make a backup of the Company and Dynamics databases

Server/Client

To install FTE Manager downloaded the exe file from our website. Once the files have been downloaded, you can run them on the Server and/or Client Installations. The product will need to be installed on all machines that process payroll.

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® Components. Creating the Microsoft SQL Server Components needs to be performed on a single computer, typically the server.

1. Right click Integrity Data GP2018 Setup.exe file and select “Run as Administrator”. If you do not see this option, hold the shift key down and right click.

2. Complete the steps in the wizard
3. Verify the GP directory is correct if it is not select Change
4. Select Custom to choose to install only the specific products you purchased.

5. Select Activation Components to only install activation manager files. This option will not install products and it is typically run only to fix an error with activation manager.

6. Select All Components to install all Integrity Data products. The products you did not purchase will register with a 30-day trial period.
If you are upgrading you will be prompted to uninstall the older version, select "y". If you have multiple products, it will uninstall all products.

7. Select the product(s) to install, if installing multiple products, select all that need to be installed.
Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description

HRM Solution Series Extensions

This feature requires 5056KB on your hard drive. It has 2 of 2 subfeatures selected. The subfeatures require 4380KB on your hard drive.

Install to:
C:\Program Files (x86)\Microsoft Dynamics\GP2018\  

InstallShield

Ready to Install the Program

The wizard is ready to begin installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to exit the wizard.

Current Settings:

Setup Type:
Custom

Destination Folder:
C:\Program Files (x86)\Microsoft Dynamics\GP2018\n
User Information:
Name: Windows User
Company:

9. If prompted to include new code, choose yes.

10. Login as the ‘system administrator’ for each company to create the SQL Server components.

11. The system will auto activate the products you have purchased if you have access to the internet on the machine. If you receive a message Activation Manager failed contact support@integrity-data.com and include a screenshot of the Activation Manager window to receive manual keys.

**BEST PRACTICES**

- Install is not a requirement on the **Server**; however it is recommended.
- Install updated version on previously installed **Client** machines.
Files Installed

The following files are installed:

GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
- HRMSSEXT.cnk or HRMSSEXT.dic
- Application.IntegrityDataActivation.dll
- Integrity.Registration.Constructor.dll
- Integrity.Registration.Addin.dll
- IDA6537.cnk

Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)
- FTE Manager User Guide.pdf

Manual Install

If the user encounters errors during the installation, complete the following steps to manually install FTE Manager:

1. Contact support@integrity-data.com to receive the manual install files for the product(s).
2. Copy and paste the following files into the appropriate locations.

   GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
   - HRMSSEXT.cnk or HRMSSEXT.dic
   - Application.IntegrityDataActivation.dll
   - Integrity.Registration.Constructor.dll
   - IDA6537.cnk
   - Integrity.Registration.Addin.dll

   Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)
   - FTE Manager User Guide.pdf

3. Edit the Dynamics.exe.config
   a. Navigate to the GP folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
   b. Backup the Dynamics.exe.config by making a copy and saving the copy **Important**
   c. Open Dynamics.exe.config in Notepad
   d. Find the <addin> and under <Dynamics> copy and paste the following:
      <addin name="IDKeyManagerAddIn"
      type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37e2026e3bc"/>
   e. Under <DynamicsGPweb> copy and paste the following:
      <addin name="IDKeyManagerAddIn"
      type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37e2026e3bc"/>
4. Launch Microsoft Dynamics GP.
5. Login as the ‘system administrator’ for each company to create the SQL Server components.
Registration

The system will automatically activate the product during the log in process. If the activation was successful, the user will not receive any messages. However, if the activation process was unsuccessful the user will receive a message. If the activation process fails the user will need to open the Activation Manager window to activate the product.

Activation Manager Window

Microsoft Dynamics GP > Tools > Setup > System > Activation Manager

The Site Name defaults from the session information on the About Microsoft Dynamics GP window.

From the Product drop-down list the user may select the product they wish to activate and review product information. Once the product is selected the following fields will display:

- Installed Version – Current version number installed.
- Enhancement Plan Date – Date of the enhancement plan expiration.
- Activation Status – Current status of the product.
  - Permanent – Product has been purchased.
  - Trial – Product has been issued a trial period.
  - Deactivated – Product has been deactivated.
- Current Employees – This count defaults from the session information on the About Microsoft Dynamics GP window. The count does not include inactive employees or employees in a Test or Historical company. If the current employee count is incorrect validate Test or Historical companies are named correctly.
• Employees Allowed – The number of employees allowed before the product will be inactivated. If the Current Employees exceeds the Employees Allowed the system will deactivate the product.

The scrolling window contains a list of all companies; by default the product is active for all companies. If the user would like to inactivate a company unmark the company checkbox.

The Auto Activation option may be selected if the user receives a message at log in stating the product is not activated. When the user selects the Auto Activation option the system will attempt to automatically activate the product. Once the Auto Activation process is complete the system will display the Activation Messages. For a detailed list of activation messages see the Activation Manager Messages section.

The Manual Activation option is used to manually enter a token. The user would only manually enter a token if they were sent a token by Integrity Data.

Select the OK button to close the window.

Test and/or Historical Companies
Registration will not count the active employees in Test or Historical company databases if the Company Name is named correctly, specifically at the end of the Company Name the user must append the following: “<TEST>” or “<HISTORICAL>”.

• Dextordinary, Inc. <TEST>
• Dextordinary, Inc. <HISTORICAL>

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified.

Version Information
To obtain the latest FTE Manager version information, visit our website.

Within Microsoft Dynamics GP verify the version for FTE Manager by selecting the Help Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the FTE Manager window appears.
Security Settings

The Security Task Setup window may be used to grant or restrict access to the FTE Manager windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select Security Tasks and enter the system password.

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below:
   • Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User Security), select the appropriate user and make a note of the Security Role ID assigned to the user.
   • Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security Roles), select the Role ID that has been assigned to the user and make note of the Security Task ID assigned to the Role. Use this Task ID to grant security to the FTE Manager.
     NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks

2. Select FTE Manager for the Product.

3. Select Windows for the Type and select 3rd Party for the Series.

4. Use the Access List to grant or restrict access to individual items.
   • To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark the item.
   • Click the Mark All button to grant access to all items in the list or click the Unmark All button to restrict access to all items in the list.

5. Click File > Print to print the Security Task Setup Report for the selected Task ID.

6. Choose OK to save your changes.

FTE Manager > Windows > 3rd Party > Access List

- Copy Employee Positions
- Employee Positions Maintenance
- Employee Split Lookup
- Employee Split Setup
- Payroll Account Options
- FTE Manager Password Entry
- FTE Manager Budget Import
- FTE Manager Budget Maintenance
- FTE Manager Hire
- Payroll Transaction GL Account
- FTE Manager Maintenance
- FTE Manager Password Setup
- FTE Manager Pay Code Setup
- FTE Manager Requisition
• FTE Manager Statistics by Status
• Position Status Lookup
• Progress Control
• Registration Key Entry
• Status Setup
• Year

FTE Manager > Reports > 3rd Party > Access List

• APR Account Validation Report
• APR Employee Pay Detail Report
• APR Employee Split Detail Report
• APR Pay Code Setup Report
• APR PC Budget Maintenance
• APR PC Manager Master
• APR PC Statistics by Status
• APR Status Setup
Status Setup Window

Microsoft Dynamics GP > Tools > Setup > Payroll > Status Code Setup

The Status Code Setup window provides the user the ability to create FTE Manager Status Codes, map the code to an existing HR Status Code and determine the codes impact to FTE calculations.

- **Status Code** – select a Status Code by typing the Status Code or utilizing the Lookup button.
  - Status Code Lookup button – opens the Position Status Lookup window which allows the user to select the Status Code.
- **Description** – enter or modify the description of the Status Code.
- **Maps to HR Status** – type the first letter of the HR Status or utilize the drop-down list to select the HR Status. This provides the user the ability to map FTE Manager Status Codes to HR Status Codes. This field is display only when recalling saved records.
- **Include in FTE Count** check box – if the check box is checked, then the Status Code will impact FTE calculations in the FTE Manager Maintenance and the FTE Manager Budget Maintenance windows. This field is display only when recalling saved records.
- **Exclude During Copy** – when checked any record in the selected Year with this Status is not copied during a copy process.
- **Inactive** – cannot be assigned to an employee and does not appear in the Status Code Lookup window.
- **Save button** – select this button to save the record.
- **Clear button** – select this button to clear the current window.
- **Delete button** – select this button to delete the current record.
- **Printer button** – select this button to print the Status Setup List report.
<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
<th>Include in FTE Count</th>
<th>Inactive</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVE</td>
<td>ES-ACTV</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ES-HIRE</td>
<td>Hired - Started Working</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ES-LOAFAM</td>
<td>Family Leave of Absence</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ES-RETR</td>
<td>Retirement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ES-TERM</td>
<td>Terminated</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The FTE Manager Password Setup window enables the user to create a password to prevent users from performing the following actions without first entering the FTE Manager Password:

- Saving a new Employee in the Employee Maintenance window.
- Inactivating an existing Employee in the Employee Maintenance window.
- Assigning a FTE Amount that exceeds the Budgeted FTE Amount in the FTE Manager Hire, Employee Positions Maintenance and FTE Manager Requisition windows.

- Old Password – if a password has been set, enter the Old Password prior to entering the New Password and Reenter New Password.
- New Password – enter a new password.
- Reenter New Password – reenter the new password.
- Save New Employee – if this check box is selected, it will require a password when Saving a new employee within the Employee Maintenance window.
- Inactivate Employee – if this check box is selected and the user selects to Inactivate an employee within the Employee Maintenance window, the system will prompt the user to enter the FTE Manager Password.
- Exceed Budget for FTE Manager Hire – if this check box is selected, and the user assigns an Employee FTE on the FTE Manager Hire window that exceeds the Available FTE the system will prompt the user to enter the FTE Manager Password.
- Employee FTE Exceeds Budget for Position – if this check box is selected, and the user assigns an Employee FTE on the Employee Positions Maintenance window that exceeds the Available FTE the system will prompt the user to enter the FTE Manager Password.
• Exceed Budget for FTE Manager Requisition – if this check box is selected, and the user assigns a Requisition FTE on the FTE Manager Requisition window that exceeds the Available FTE the system will prompt the user to enter the FTE Manager Password.
FTE Manager Pay Code Setup Window

Microsoft Dynamics GP > Tools > Setup > Payroll > FTE Manager > FTE Manager Pay Code Setup

The FTE Manager Pay Code Setup window provides the user the ability to select the Pay Codes that are included in the calculations for Actual Dollars and Actual FTEs within the FTE Manager Maintenance and FTE Manager Budget Maintenance windows for the Fiscal Year + Department + Position combination selected.

If the FTE Manager Pay Code Setup window is modified mid-Fiscal Year the Actual FTE’s and Actual Dollars on the FTE Manager Maintenance and FTE Manager Budget Maintenance window will be impacted for all Payroll Transactions in the selected Fiscal Year.

- Year – select the Fiscal Year by typing the Fiscal Year or utilizing the drop-down list. This list is generated from Fiscal Period Setup window.

Pay Codes Scrolling Window

- Pay Code – select the Pay Code by typing the Code or utilizing the Lookup button. The Pay Codes are from the Microsoft Dynamics® GP Core Pay Code Setup window.
  - Pay Code Lookup button – opens the Pay Codes Lookup window that allows the user to select a Code.
- Description – displays the description from the Microsoft Dynamics® GP Core Pay Code Setup window for corresponding Pay Code.
- Use Hours check box – if the check box is checked, hours from the corresponding Pay Code transactions will impact Actual FTE calculation values.
• Use Dollars check box – if the check box is checked, dollars from the corresponding Pay Code transactions will impact Actual Dollar calculation values.

• OK button – select this button to save the record and close the window.

• Clear button – select this button to clear the current window.

• Printer button – select this button to print the FTE Manager Pay Code Setup.
Employee Maintenance Window

If a user inactivates an employee, the system will notify the user to modify the Employee Positions Maintenance records for the selected employee to make the associated employee's FTE's available for requisition.

If a user creates a new employee, the system will prompt the user to create Employee Positions Maintenance records for the employee on initial save only.

- Additional Positions button – opens the Employee Positions Maintenance window.
- The Employee Positions Maintenance window has been added to the Human Resources GoTo button.
Employee Additional Information Maintenance Window

If a user attempts to change Work Hours per Year and there are multiple active Employee Positions Maintenance records present for the selected employee, the system will prompt the user, “Employee Positions Maintenance records exist, edit Work hours per year in the Employee Positions Maintenance window.”

- OK button – will not allow the user to change the Work Hours per Year.
Employee Human Resources Maintenance Window

If a user attempts to change the HR Status, the system will prompt the user, “Change the status in the Employee Positions Maintenance window.”

- When the OK button is selected, the system opens the Employee Positions Maintenance window for the selected Employee ID. If the current year exists that corresponds to the current fiscal year as determined by the date in the User Date field and Fiscal Periods Setup, it is displayed.
**FTE Manager Budget Maintenance Window**

**Cards > Payroll > FTE Manager > FTE Manager Maintenance > GoTo > Budgets**

**Cards > Payroll > FTE Manager > FTE Manager Budget Maintenance**

The FTE Manager Budget Maintenance window allows the user to view and modify budget related data by period for the selected Fiscal Year + Department + Position combination.

- **Year** – select the Fiscal Year by typing the Fiscal Year or utilize the drop-down list. The list is generated from Fiscal Period Setup.
- **Department** – select the Department by typing the Code or utilizing the Lookup button.
  - **Department Lookup** – opens the Departments Lookup window which allows the user to select a Department code.
  - **Description** – displays the description from the Department Setup window.
- **Position** – select the Position by typing the Code or utilizing the Lookup button.
  - **Position Lookup** – opens the Positions Lookup window which allows the user to select a Position code.
  - **Description** – displays the description from the Position Setup window.
- **Calculate Button** – calculates Actual FTEs and Actual Amounts for the select Fiscal Year.

**Budget by Period Scrolling Window**

- **Budget Amount** – enter Budget Amount for the selected period.

*A Fiscal Year is the only REQUIRED field to calculate.*
• Budget FTEs – enter Budget FTEs for the selected period.

• Actual Amount – displays from the Payroll Transactions for the selected Fiscal Year + Department + Position combination based on settings in the FTE Manager Pay Code Setup window at the time of Payroll processing. The status code that is assigned to the employee must have the option “Include in FTE Count” selected to be included in the Actual Amount.

• Actual FTEs – displays from the Payroll Transactions for the selected Fiscal Year + Department + Position combination based on settings in the FTE Manager Pay Code Setup window at the time of Payroll processing. The status code that is assigned to the employee must have the option “Include in FTE Count” selected to be included in the Actual FTEs.

• Budget Total – totals the Period Budget Amounts.

• Actual Total – totals the Period Actual Amounts.

• OK button – select this button to save the record and close the window.

• Clear button – select this button to clear the current window.

• Printer button – select this button to print the FTE Manager Budget Maintenance report.

![Screen Output - APR PC Budget Maintenance](image)

<table>
<thead>
<tr>
<th>Department</th>
<th>Position</th>
<th>Year</th>
<th>Period</th>
<th>Budget Amount</th>
<th>Budget FTE</th>
<th>Actual Amount</th>
<th>Actual FTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCT</td>
<td>ADA</td>
<td>2017</td>
<td>Period 1</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 2</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 3</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 4</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 5</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 6</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 7</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 8</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 9</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 10</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 11</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Period 12</td>
<td>20,007.63</td>
<td>0.00</td>
<td>397.59</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Year Total</td>
<td>240,451.53</td>
<td>0.00</td>
<td>15,490.71</td>
<td>1.00</td>
</tr>
</tbody>
</table>
FTE Manager Maintenance Window

The FTE Manager Maintenance window allows the user to view data related to the employees assigned to a particular Fiscal Year + Department + Position combination.

If an employee is assigned to the selected Department + Position combination on the Employee Card, but does not have an existing Employee Positions Maintenance record for the selected Fiscal Year, the system will display the Employee ID and Name only. All other data related fields for the employee will be blank.

GoTo Button

- **Budgets** – opens the [FTE Manager Budget Maintenance window](#).
- **Requisitions** – opens the Microsoft Dynamics GP Core [Requisitions window](#).
- **Statistics by Status** – opens the [FTE Manager Statistics by Status window](#).
- **Employee Positions Maintenance** – opens the Employee Positions Maintenance window.
- **Year** – select the Fiscal Year by typing the Year or utilizing the drop-down list. This list is generated from the Fiscal Periods Setup window.
- **Department** – select the Department by typing the Code or utilizing the Lookup button.
  - **Department Lookup** – opens the Departments Lookup window which allows the user to select a Department Code.
- Description – displays the description from the Department Setup window.

- Position – select the Position by typing the Code or utilizing the Lookup button.
  - Position Lookup – opens the Positions Lookup window which allows the user to select a Position code.
  - Description – displays the description from the Position Setup window.

- Budget Statistics
  - Annual Budget FTEs – enter the budgeted FTEs for the selected Fiscal Year + Department + Position combination.
  - Annual Budget Amount – displays the Budget Total from the FTE Manager Budget Maintenance window for the selected Fiscal Year + Department + Position combination.
  - Annual Actual FTEs – displays from Payroll Transactions combination based on current settings in the FTE Manager Pay Code Setup window.
  - Annual Actual Amount – displays from Payroll Transactions combination based on current settings in the FTE Manager Pay Code Setup window.
  - Annual Variance FTEs – displays the calculated amount of Budget FTEs less Actual FTEs.
  - Annual Variance Amount – displays the calculated amount of Budget Amount less Actual Amount.

- Vacancy Statistics
  - Current Vacant FTEs – displays calculated amount of Budgeted FTEs less Filled FTEs.
  - Current Filled FTEs – displays calculated amount of Total FTEs from Employee Positions Maintenance for Status Codes set to include in FTE Count for the selected Fiscal Year + Position + Department combination.
  - Current Requisitioned FTEs – displays calculated amount of Total FTEs for the selected Fiscal Year + Position + Department combination from the FTE Manager Requisition window.

Employee Assigned to this Position Scrolling Window

Displays Employees currently assigned to the selected Fiscal Year + Position + Department combination in the Employee Positions Maintenance window. Users have the ability to double-click on an employee and “drill down” to the Employee Positions Maintenance record.
• Employee ID – displays from the Employee Positions Maintenance window records for the selected.

• Name – displays from the Employee Positions Maintenance window records for the selected.

• FTE – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Status – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Start Date – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• End Date – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

Employee Assigned to this Position EXPANDED Scrolling Window

• Status Description – displays the description from the Status Setup.

• Work Hours per Year – displays from the Employee Positions Maintenance window for the corresponding Employee ID.
• Primary Position – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Division – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Location – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Supervisor – displays from the Employee Positions Maintenance window for the corresponding Employee ID.

• Save button – select this button to save the record.

• Clear button – select this button to clear the current window.

• Delete button – select this button to delete the current record.

• Redisplay button – select this button to redisplay the current record.

• Printer button – select this button to print the FTE Manager Maintenance report.
FTE Manager Requisition Window

The FTE Manager Requisition window will provide the user the ability to assign an FTE to a Requisition for a particular Fiscal Year + Department + Position combination.

Once the user selects the Save button on the Dynamics GP Requisition window, the system will pop-up the FTE Manager Requisition window.

When the user exits the FTE Manager Requisition Window, the system will compare the Requisition FTE entered to the Available FTE. If the user assigns a Requisition FTE on the FTE Manager Requisition window that exceeds the Available FTE the system will prompt the user to enter the FTE Manager Password if enabled in the FTE Manager Password Setup window. Otherwise, the user will receive an error message and not allow the Requisition FTE to be assigned.

- **Requisition No.** – displays from the requisition currently open.
- **Year** – displays the Fiscal Year from the User Date. For example, to requisition for a specific Fiscal Year ensure your User Date is set to a date that falls within the targeted Fiscal Year.
- **Department** – displays from the requisition currently open.
- **Description** – displays the Department description from the requisition currently open.
- **Position** – displays only from the requisition currently open.
- **Description** – displays the Position description only from the requisition currently open.
- **Requisition FTE** – assign the FTE amount for the current requisition.
- **Budget FTE** – displays from the FTE Manager Maintenance window for the selected Fiscal Year + Department + Position combination.

P a g e 33 | 57
• Actual FTE – displays from the FTE Manager Maintenance window for the selected Fiscal Year + Department + Position combination.

• Total Open Requisition FTE – total of the FTE assigned to Open Requisitions for the selected Fiscal Year + Department + Position combination.

• Available FTE – is calculated as Budget FTE less Actual FTE less Total Open Requisition FTE.
FTE Manager Hire Window

The FTE Manager Hire window will provide the ability to assign a FTE amount to a new Hire record.

Once the user selects the Save button on the Dynamics GP Hire window, the system will pop-up the FTE Manager Hire window.

- Employee ID – displays from the Hire record currently open.
- Year – select the Fiscal Year by typing the Fiscal Year or utilizing the drop-down list. This list is generated from the Fiscal Periods Setup.
- Department – displays from the Hire record currently open.
- Position – displays from the Hire record currently open.
- Available FTE – calculates as Budget FTEs less Filled FTEs from the FTE Manager Maintenance window for the selected Fiscal Year + Department + Position combination.
- Requisition FTE – total of the FTE assigned to Open Requisitions for the selected Fiscal Year + Department + Position combination.
- Employee FTE – assign the FTE amount for the hire record currently open.

When the user exits the Employee FTE field, the system will compare the FTE entered to the Available FTE.

If the Employee FTE exceeds the Available FTE the system will prompt the user to enter the FTE Manager Password if enabled in the FTE Manager Password Setup window. Otherwise the user will receive an error message a not allow the Employee FTE to be assigned.
Employee Positions Maintenance Window

Cards > Payroll > Employee Positions Maintenance

Cards > Payroll > Employee > Additional Positions button

Cards > Payroll > Employee > GoTo > Human Resources > Employee Positions Maintenance

The Employee Positions Maintenance window is an alternate window to the Microsoft Dynamics® GP Core Employee Positions window. This feature allows the user to enter multiple Department / Position combination records by Fiscal year. Use the Employee Positions Maintenance window to view or delete an employee’s job. A job is defined as a Department and Position combination. You can view division, department, position, location and supervisor information. You also can view the effective beginning and end date of the position and the full time equivalency for the position. You can delete an employee’s position if the position is not the employee’s primary position. The system will allow multiple Department / Position combinations to be entered and tracked for each year. This window also allows for additional reporting fields. Changes are saved to history tables also for reporting purposes.

If a user assigns an employee to a Fiscal Year + Department + Position combination and the FTE amount assigned to the current record plus the Current Filled FTEs from the FTE Manager Maintenance window is greater than the Budgeted FTEs from the FTE Manager Maintenance window the system will prompt the user for the FTE Manager Password (only if enabled in the FTE Manager Password Setup window) and allow the change.

- Employee ID [REQUIRED] – select an Employee ID by typing the Employee ID or utilizing the Lookup button.
  - Employee Lookup button – opens the Employees Lookup window which allows the user to select an Employee.
• Year [REQUIRED] - The drop-down list displays all years for which the employee has records.

  If the employee has a record for the current year as determined by the year in the User Date field that corresponds to the Fiscal Periods Setup year, the current fiscal year will be displayed.

  If a current year record has not been set up then the most recent prior fiscal year record will display if it exists.

  If a current year or prior year record does not exist then the closest future year will be displayed.

  If no employee record exits, the field will be blank.

To retrieve previous or future Year records select the Year from the drop-down list.

To create records for a year that does not exist, type the Year in the Year field and tab off, you will be prompted, “A fiscal Period Does Not Exist For The Year Entered. Setup The Fiscal Period First.”

Prior years do not require the Fiscal Periods Setup to be setup.

When there are records from previous years and the Fiscal Year does exist for the current or future year being entered, you will be prompted, “You have entered a year that has not yet been setup for this employee. Do you want to copy the data from the previous year to this year?”

Select:

• Yes – will copy the most recent year from the existing Employee Positions Maintenance records according to the setup of the Status field. When a status is not assigned to the record, the record will be copied.

• No – will not complete the copy process, and will allow the user to create new records for the selected employee for the new Year.

Department and Positions Assigned to this Employee EXPANDED Scrolling Window

Use the Copy Employee Positions window to mass update all or multiple employees. See Copy Employee Position section later in the document.
• Department [REQUIRED] – select a Department by typing the code or utilizing the Lookup button.
  o Department Lookup button – opens the Departments Lookup window which allows the user to select a Department by Code.

• Position [REQUIRED] – select a Position by typing the code or utilizing the Lookup button.
  o Position Lookup – opens the Positions Lookup window that allows the user to select a Position by Code.

• Primary Position [Primary Position is a REQUIRED field for one record per Year] – check this check box if the selected job is the primary job for this employee. A record marked as Primary cannot be deleted for that year. A record marked as Primary cannot be deleted for that year. The Primary checkbox controls which record is synchronized with the home department and position on the Employee Maintenance window.

• Status – select a Status by typing it or utilizing the drop-down list. Only Active records will impact processed payroll transactions.
  o Status Lookup – opens the Status Lookup window which allows the user to select a Status by Code.

• Position FTE – enter the Full-time Equivalency for the selected job.

• Account Number – can be entered by typing it, selecting the Lookup button or utilizing the Expansion button. Payroll Transactions processed for the selected Year, Department and Position will be posted to the GL Account entered. If no Account is entered the system will look to the Payroll Posting Accounts Setup to determine the GL Account applied. Employee Split records that meet the Split Criteria override any records created within the Employee Positions Maintenance window.
- Account Lookup button – opens the Accounts Lookup window which allows the user to select the Account number.

- Account Expansion button – opens the Account Entry window which allows the user to select a GL account by Alias.

- Division – select assigned Division to this job.
  
  - Division Lookup button – opens the Divisions Lookup window which allows the user to select by Division Code.

- Division Description – displays the Division name from the Division Setup window.

- Department Description – displays the Department name from the Department Setup window.

- Position Description – displays the Position name from the Position Setup window.

- Location – displays the Address ID assigned to the current record.
  
  - Location Lookup button - displays the Company Address IDs from the Company Addresses Setup window which allows the user to select the Company Address ID.

- Location Description – displays the Location name from the Location Setup window.

- Supervisor – select assigned Supervisor to this job.
  
  - Supervisor Lookup button – opens the Supervisor Lookup window which allows the user to select by Supervisor Code.

- Supervisor Description – displays the description from the Supervisor Setup window.

- Pay Code – select a Pay Code by typing the code or utilizing the Lookup button.
  
  - Pay Code Lookup – opens the Employee Pay Codes Lookup window which allows the user to select the Pay Code.

- Pay Code Description – displays the description from the Pay Code Setup window

- Effective Begin Date – starting date for the job. The Effective Begin Date will be prior to the Effective End Date.

- Effective End Date – ending date for the job.

- Hours/Day – enter average hours worked per day for the selected job.

- Days/Year – enter average days worked per year for the selected job.

- Hours/Year [REQUIRED] – this is a calculated field that multiples hours per day times days per year.

An Employee, Department and Position combination must be selected prior to clicking the Expansion button or utilizing the Account Lookup.
The system calculates the Hours / Year value when either the Hours / Day or Days / Year have a value > 0 and the Hours / Year = Hours / Day times Days / Year.

The system will sum the Hours / Year for all Department / Position combinations on the Employee Positions Maintenance window. The system will assign the sum to the Employee Maintenance > Additional Information > Work Hours Per Year field. This sum must be greater than 0.

If the user assigns a status which is not “Active” the user will receive the following message.

Select Yes:

If you do not want the Hours / Year for that Department / Position combination to be added to Work Hours Per Year field on the Employee Additional Information Maintenance window.

Select No:

If you do want the Hours / Year for that Department / Position combination to be added to Work Hours Per Year field on the Employee Additional Information Maintenance window.

When the Work Hours per Year field on the Employee Maintenance > Employee Additional Information Maintenance window changes, the user is prompted, “Employee Pay Details records exist, edit Work hours per Year in the Employee Pay Details window.”

- When the OK button is selected, the system opens the Employee Positions Maintenance window for the selected Employee ID. If the current year exists that corresponds to the current fiscal year as determined by the date in the User Date field and Fiscal Periods Setup, it is displayed.
- See additional information in the Modified Records section.

- Annual Pay and Rate / Hour:

  - When the Pay Code field has a value and is a Salary Pay Type, for the Annual Pay, the system will display the Pay Rate from the Employee Pay Code Maintenance window and the Rate / Hour = Pay Rate divided by Hours / Year
o When the Pay Code field has a value and is a Hourly Pay Type, for the Rate / Hour, the system will display the Pay Rate from the Employee Pay Code Maintenance window and the Annual Pay = Pay Rate times the Hours / Year

o The system will refresh the information when the Hours / Year changes

o When the Pay Code field is empty, the system will display the Annual Pay and Rate / Hour as 0.

- Refresh button – click this button it will refresh the scrolling window.
- Delete Row button – a record must be selected before clicking this button. Then the user will be prompted, “Are you sure you want to delete this record?” Click Delete to delete the row or click Cancel to cancel the deletion process.
- Scrolling Window Expansion button – click the button to show the additional reporting fields for each entry.
- Record Level Note – Notes that can be attached to the employee
- Previous button – retrieves the previous job for the selected employee.
- Next button - retrieves the next job for the selected employee.
- Validate Accounts button – this button does not apply to FTE Manager.
- Splits button – this button does not apply to FTE Manager.
- OK button – select this button to save the record and close the window.
- Clear button – select this button to clear the current window.
- Redisplay button – select this button to redisplay the current record.
- Window Level Note – Notes that can be attached to the window
- Printer button – select this button to print the Employee Pay Detail Report.
FTE Manager Statistics by Status Window

Cards > Payroll > FTE Manager > FTE Manager Maintenance > GoTo > Statistics by Status

The FTE Manager Statistics by Status window will provide the user the ability to view FTE information by Status Code for a particular Fiscal Year + Department + Position combination.

![FTE Manager Statistics by Status Window](image)

Year – select the Fiscal Year by typing the Fiscal Year or utilizing the drop-down list. This list is generated from the Fiscal Periods Setup.

- Department – select the Department by typing the Code or utilizing the Lookup button.
  - Department Lookup – opens the Departments Lookup window which allows the user to select a Department code.
  - Description – displays the description from the Department Setup window.

- Position – select the Position by typing the Code or utilizing the Lookup button.
  - Position Lookup – opens the Positions Lookup window which allows the user to select a Position code.
  - Description – displays the description from the Position Setup window.

- Current Vacant FTEs – displays calculated amount of Budgeted FTEs less Filled FTEs.

- Current Filled FTEs – displays calculated amount of Total FTEs from Employee Positions Maintenance for Status Codes set to include in FTE Count for the selected Fiscal Year + Position + Department combination.

- Current Requisitioned FTEs – displays calculated amount of Total FTEs for the selected Fiscal Year + Position + Department combination from the Requisition FTE Manager window.
FTEs by Position Status Scrolling Window

Displays totals from records assigned to the selected Fiscal Year + Department + Position combination in the Employee Positions Maintenance window.

- Status Code – displays from the Status Setup. This allows the user to sort by this column.
- Position Status – displays from the Status Description from the Status Setup window.
- Updates FTEs – displays from the Status Setup. This allows the user to sort by this column.
- HR Status – Display-only from Status Setup. This allows the user to sort by this column.
- Total FTEs – displays the calculated as Total FTEs assigned in Employee Positions Maintenance to the selected Fiscal Year + Department + Position combination for current Status Code. This allows the user to sort by this column.
- OK button – select this button to save the record and close the window.
- Clear button – select this button to clear the current window.
- Printer button – select this button to print the FTE Manager Statistics by Status Report.
FTE Manager Budget Import Window
Microsoft Dynamics GP > Tools > Utilities > Payroll > FTE Manager Budget Import

The FTE Manager Budget Import window allows the user to import FTE Manager budget data by Fiscal Year + Department + Position + Period combination.

- Import button – select this button to Import the CSV (Comma Separated Value) file.
- Cancel button – select this button to cancel the import and close the window.
- Filename – enter the CSV filename to be imported or utilize the ellipsis button to browse for the file.

CSV File
The first line of the CSV file must be the Column Headings. All seven of these headings must be present in the following order and they are case sensitive:

1. Year – valid Fiscal Year
2. Department – valid Department
3. Job Title – valid Position
4. Period ID – valid numeric Period ID
5. APR Period Budget FTE – numeric budgeted Period FTEs
6. APR Period Budget Amount – numeric budgeted Period Amount
7. APR Annual Budget FTE – numeric Budgeted Annual FTEs. The FTEs assigned to the greatest Period ID for each Fiscal Year + Department + Position combination will be imported to the Annual Budgeted FTEs.
If the system is unable to validate the file format the system will display, "Import file does not follow standard format."

- OK button – will close the error message.
Copy Employee Positions Window

Microsoft Dynamics GP > Tools > Utilities > Payroll > Copy Employee Positions

HR & Payroll > Utilities > Payroll > Copy Employee Positions

As part of the Fiscal Year End process the Copy Employee Positions utility should be run after the last pay run of the previous year and before the first pay run of the new fiscal year. After the Previous Year and New Year values are entered, the window displays all current employees.

- Previous Year [REQUIRED] – enter the previous year.
- New Year [REQUIRED] – enter the new year.
- Mark All button – select to mark all employees listed.
- Unmark All button – select to unmark all employees listed.
- Copy button – copies all the selected employee’s records from the Previous year to the New year. The New Fiscal year must be set up first.
Payroll Processing

During the Build Process the system prompts ‘Print Account Validation Report? This may increase processing time required for Build Checks.’

- If the user answers Yes, the system ensures it is able to generate validate Account Numbers:
  - Valid Account Number – If the system is able to generate valid accounts for all Employee records, the user is prompted, “No errors.”
  - Invalid Account Number - If the system is unable to generate valid accounts, the system prompts the user to print the Account Validation Report. Modifications to either the Employee Positions Maintenance record, Employee Split Setup record, Payroll Posting Account Setup or Payroll Account Options are required before processing affected Payroll Transactions.

- If the user answers No and the system is unable to generate valid GL Accounts during the Calculate Process, the user receives an error that system was unable to post specific payroll transactions and the user is required to correct the errors in the Payroll Posting Account Setup, Payroll Account Options, Employee Positions Maintenance window or the Employee Splits Setup window and reprocess the payroll.
Fiscal Year End Process

The Copy Employee Positions utility needs to be run after the last pay run of the previous year and before the first pay run of the new fiscal year.
Organizational Explorer Window

Cards > Human Resources > Organizational Explorer

The Organization Explorer window now allows the user to view FTEs assigned in the Employee Positions Maintenance window by Fiscal Year.

A user may change the User Date to view alternate Fiscal Year information.
Exporting Utilizing SmartList Builder

SmartList Builder can be utilized to create a Microsoft Excel workbook for the purpose of editing current Budgets and creating future Budgets.

- SmartList ID – enter a SmartList ID or utilize the Lookup button.
  - SmartList ID Lookup button - opens the SmartList Lookup window which allows the user to select a SmartList ID.
- SmartList Name – enter a Name for the SmartList ID.
- Item Name – enter an Item Name for the SmartList ID.

To complete an Export of the CSV file, complete the following steps: (see above screen shot for assistance)

1. Select + within the Tables section and select Microsoft Dynamics® GP Table within the SmartList Builder window.
2. Within the Add Table window, select the following:
   - Product: HRM Solution Series Extensions
   - Series: Payroll
   - Table: FTE Manager Budget Master

   Click Save.
3. Select + within the Tables section and select Microsoft Dynamics® GP Table within the SmartList Builder window.

4. Within the Add Table window, select the following:
   - **Product**: HRM Solution Series Extensions
   - **Series**: Payroll
   - **Table**: FTE Manager Master
   - **Link To Table**: FTE Manager Budget Master
   - **Link Method**: Equals
   
   Click +.

5. Within the Add Link window, select the following:
   - **From Field**: Year
   - **To Field**: Year
   
   Click Save.

6. Within the Add Link window, select the following:
   - **From Field**: Department
   - **To Field**: Department
   
   Click Save.

7. Within the Add Link window, select the following:
   - **From Field**: Job Title
   - **To Field**: Job Title
   
   Click Save.

8. Within the Add Table window select Save.

9. Select the FTE Manager Budget Master table, select APR Annual Budget FTE, then select .
   
   Within the Set Field Options window uncheck **Show Currency Symbol** and **Show Thousands Separator**. Then select Save within the SmartList Builder window.

10. Repeat Step 9 for Display Names APR Period Budget Amount, APR Period Actual FTE and APR Period Actual Amount.
11. Select the drop down arrow and select Mark All within the SmartList Builder window (see SmartList Builder window above).

12. Select the FTE Manager Master table; select the check box within the Default column for APR Annual Budget FTE and APR Annual Actual FTE within the SmartList Builder window.

13. Once the SmartList object is created, the user must setup security before accessing the SmartList object.

14. View your SmartList, navigate to the SmartList ID and then select Excel.
Run the Calculate on the FTE Manager Budget Maintenance window for any years that will be budgeted prior to running the SmartList.
Activation Manager Messages

Activation Failed: Trial invalid or trial period expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Activation Failed: Site name does not match this installation
Situation: The site name does not match the token which was issued.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

Activation Failed: Product Name does not match this installation
Situation: The product name does not match the token which was issued for a product.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

Trial period for FTE Manager has expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Employees Allowed has been exceeded
Situation: The current employee count has exceeded the employees allowed.
Solution: Contact sales@integrity-data.com to upgrade to the next tier.

Activation Failed: Unable to contact web service. Activate manually or revert to previous product dictionary
Situation: The system could not make a connection to the web service.
Solution: Contact support@integrity-data.com for assistance.

Activation Failed: Product has been deactivated
Situation: The product has been deactivated.
Solution: Contact support@integrity-data.com for assistance.

Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to previous product version.
Situation: User attempted to upgrade a product when their enhancement plan was expired.
Solution: Contact sales@integrity-data.com to renew the enhancement plan.

FTE Manager: Activation Failed
Situation: Communication breakdown between the user machine and Integrity Data.
Solution: Contact support@integrity-data.com for assistance.
Deactivate Product

There are two ways to deactivate the FTE Manager; disable or uninstall.

Disable

To disable FTE Manager without having to exit Microsoft Dynamics GP, open the Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and then click Customization Status. Select the product from the list and click Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP.

Uninstall

If FTE Manager needs to be uninstalled complete these steps on the server and the client where FTE Manager has been installed.

1. Remove the HRMSSEXT.DIC file from the Runtime Directory
   Default location is C:\Program Files (x86)\Microsoft Dynamics\GP2018

2. Make a copy of the Dynamics.set file

3. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:
      4959
      FTE Manager
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/HRMSSEXT.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/F4959.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/R4959.DIC

4. Save the Dynamics.set file

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Uninstall Activation Manager

Activation Manager will manage activation for all Integrity Data Products. If you are uninstalling all Integrity Data products, you need to remove the Activation components.

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the Activation Manager components.

1. Make a copy of the Dynamics.set file
2. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:

   6537
   Integrity Data Activation
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/IDA6537.DIC
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537F.DIC
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537R.DIC

1. Save the Dynamics.set file

Make a copy of the Dynamics.exe.config file.

3. Edit Dynamics.exe.config and find the line(s) beginning with:
   <addin name="IDKeyManagerAddin"

4. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections.

5. Save the Dynamics.exe.config file

2. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Contact Information

Get quick answers to your questions

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162.

If you have registered your product, Technical Customer Service is available for any customers with a current Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support should always be your VAR (if you have one).

Join our User Groups

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join!

Rate us and our products

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the form on our contact page and leave your quote in the comment section.

Suggest new features or improvements

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our Director of Client Services, at tfranz@integrity-data.com or David, our Product manager at dwilmert@integrity-data.com. As always, technical ideas and user input are highly encouraged. At Integrity Data, we want to hear your input, so drop us a line!

Browse our solutions

The Integrity Data website is a great place to get additional information on products and services. The following information is available on our website:

- Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI Calculators
- Visit our Services page to learn more about our additional customization services

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail sales@integrity-data.com.